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CHAPTER 1

Introduction

This document is a manual for soil salinity assessment and monitoring using the Advanced
Monitoring and Information System (AMIS) prototype software. The AMIS was developed within
the frame of the European Project NeWater. The functionality of the system was tailored to the
requirements of the Amudarya case study in Uzbekistan. Together with local scientists, farmers,
and persons working in soil salinity monitoring and water management in the Khorezm oblast, a
methodology to assess the state of soil salinization of agricultural fields was developed. The data
used to assess soil salinity is divided into two parts: (1) local knowledge that is provided by
farmers, and (2) expert knowledge that is provided using scientific methods. Information about soil
salinity is collected and entered into the system at the field scale. Therefore, a vector map of
agricultural fields is an important prerequisite. Spatial as well as temporal data about soil salinity
are stored and administered in a database. A Geographic Information Systems (GIS) is used to
enter, access, and visualize the data. The objectives of the implementation of AMIS in the study
area are twofold. On the one hand it provides functions to integrate local and expert knowledge in
order to improve soil salinity assessment at the field scale, and on the other hand the system can be
used to monitor trends of soil salinization in the long term. Please note that the current version of
the soil salinity assessment approach has not yet been applied and needs to be verified on various
test sites.

This manual guides the user through the soil salinity functionalities of the AMIS and is focusing on
following aspects:

* Creating a soil salinity map

* Soil salinity data input

* Loading soil salinity data from the database

* Visualization of the soil salinity map

* Comparison of soil salinity at different time steps

* Reporting tool (monitoring of soil salinity trends)

1.1 Software components

The AMIS consists of various software components: (1) the Geographic Information System
SAGA GIS (http://sourceforge.net/projects/saga-gis/); (2) the object-relational database
management system PostgreSQL (www.postgresql.org); (3) the spatial extension PostGIS
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(http://postgis.refractions.net/); and (4) a GIS-database interface (GDI). Freely available and open
source software was used in all of this.

SAGA GIS is the main component of the AMIS and acts as user interface. The GDI was integrated
into the GIS and provides functions to exchange spatial and temporal data between GIS and database.
Specific functions tailored for soil salinity assessment and monitoring, such as data input,
visualization, comparison, and reporting, were implemented in the GDI.

In order to avoid the storage of data in various files, the PostgreSQL database is used to store and
administer all available data. The benefit of this approach is that the database can be installed on a
server and data provided to any system that has access to the server. Thus, the system can be used in a
multi-user mode. Alternatively, the database can be installed on the same PC as the GIS. In this case it
is a single-user system. The extension PostGIS enables the database to deal with geographic data in
vector format. This is necessary to be able to manage spatial data, such as the map of agricultural
fields for soil salinity assessment and monitoring. The OGC (Open Geospatial Consortium) Simple
Features were implemented for this purpose.

* The modified SAGA version SAGA AMIS (including the GDI and all soil salinity monitoring
functions) is available on the following website: http://www.ufz.de/index.php?en=17262

* PostgreSQL, object-relational database management system, open source, freely available,
(http://www.postgresql.org/)

* PostGIS http://postgis.refractions.net/, the spatial extension for PostgreSQL

1.2 System requirements

Although, the system is based on platform independent software components, it is currently available
for Windows operating systems (2000/XP) only. Windows Vista has not yet been tested.

In the future it is planned to provide the system also for Linux. For this purpose the modified SAGA
GIS version must be compiled under Linux.

Hardware requirements have not been tested.

1.3 Installation
SAGA

SAGA GIS runs without installation. In other words: administration rights on the computer, which are
usually necessary to install software, are not required.

Copy the SAGA directory to any directory on your hard disk and double-click in a file manager on
'saga_gui.exe' in order to start the program. Theoretically it is also possible to start SAGA from a USB
memory stick, but in this case you will probably suffer from a lack of performance, so it is not
recommended.

PostgreSQL/PostGIS

Please, see the installation instructions provided on the PostgreSQL and PostGIS hompages.



CHAPTER 2

Creating a Soil Salinity Base Map

In order to avoid the storage of soil salinity data in various files, all data — spatial as well as
temporal data — are stored in a database. In this chapter is explained how a map that represents
agricultural fields will be converted to a soil salinity base map and exported to the database. The
monitoring approach is designed to collect and store information on soil salinity at the field scale.
Therefore, the field map is the basis to give the collected data a spatial reference. Please note that
this step must be performed only once.

If the soil salinity base map already exists, this chapter can be skipped.

2.1 Loading a basis map into SAGA GIS

The basis to realize the soil salinity assessment and monitoring is a map of agricultural fields of the
area of investigation. Hence, the first step is to load an existing vector polygon map to the SAGA
Workspace. Oftentimes, such a map is available in the ESRI shape file format. To load a map into
SAGA GIS use function Load Shape File from the menu File » Shapes » Load Shapes as shown
in Figure 1 below. If such a map does not exist, it must be created first, e.g. by digitizing.

33SAGA AMIS 0.72 (2008)
File Modules Map ‘Window

Project » r[o | ? :

Table »

Shapes »

TIM A

Grid <l E:\Ne\Water!
———— [ 01, wirtual_w

Exit Features

Figure 1. Loading an ESRI shape file

Note:

It is important that the map is of type POLYGON, where each agricultural field is
represented by one polygon. Polygons are closed features and cannot be represented by
closed lines for instance. If the map is not of the proper type it is impossible to export it to
the database and to use it for this purpose.
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2.2 Modifying the attribute table

The step described in this sub-section is not necessarily required, but recommended in order to
increase the performance of the system later on and to avoid redundant information. Usually, a shape
file has an attribute table containing information that is not required for the purpose of soil salinity
assessment and monitoring. All attributes (columns) that are not necessary in this context should be
deleted, except for columns used to identify the fields, such as field number, name of owner etc.
Probably, you do not want to delete these columns from the original shape file. Hence, first save a
copy of the shape file. Therefore, right-click on the shape file in the SAGA Workspace to open the

context menu (see Figure 2). Choose a name for the copy and load this copy File » Shapes » Load
Shapes into the SAGA Workspace again.

Workspace

& Data
=& Shapes
=&} Polygon

; E virbual wua Fiele virtual_wua_Fields.shp

Show Shapes
Create Lookup Table

Edit 4

Figure 2. Saving a copy of the original shape file

How to delete columns from an attribute table is described in the following. Click on the I+ symbol
next to the copied shape file in the SAGA Workspace as shown in Figure 3 below. Double-click on the

attribute table to open it. Use the delete function in the menu Table » Delete Fields to delete the fields
that are not required.

Workspace 3¢ | Workspace *
3= Data = Data
-3k Shapes EIQ Shapes
E{j Palygon E{j Folygon
*‘:1 . virbual_wua_Ffields,shp E|{1 01, wirtual_wua_fields.shp

..... tezzlirtual wua Fields, dbF

Figure 3. Open attribute table

2.3 Database connection

Before the map (shape file) can be exported to the database make sure that a connection between GIS
and database exists. Use menu Database » Connect to Database to open the required dialog (see
Figure 4 below). Table 1 gives an explanation of the connection parameters of the dialog. If the
database is located on the same PC the host is usually /ocalhost and the port number 5432. Moreover,
the database name, the user name, and a password are required to connect to the database. If the
database is located on a server, the IP address is required additionally.
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Connect to Database x|
E Options —
Host localhost =
Hostaddress (IP) Cancel I
Port 5432
Options
ty Load I
Database Name uz_db
Save

User postgres
Password Aepddetd Ak

Figure 4. Database connection dialog

Table 1. Database connection parameters

Option

Description

Host

Hostaddress (IP)

Name of host to connect to. On machines without Unix-domain sockets,
the default is to connect to localhost.

Numeric IP address of host to connect to. This should be in the standard
IPv4 address format, e.g., 172.28.40.9. If your machine supports IPv6, you
can also use those addresses.

Port Port number to connect to at the server host, or socket file name extension
for Unix-domain connections. If the host is localhost, the port is usually
5432

Options Command-line options to be sent to the server. Usually not required in this
application, leave it blank.

tty Ignored (formerly, this specified where to send server debug output).

Database Name
User

Password

Usually not required in this application, leave it blank.
The database name to connect to.
PostgreSQL user name to connect as.

Password to be used if the server demands password authentication.

9-32

After assigning the required parameters press button Okay. If the connection command was successful,

the entries of the database menu are activated, as shown in Figure 5.

2.4 Creating and exporting the soil salinity base map

After the basis map of agricultural fields has been modified and loaded into the SAGA Workspace and
the connection to the database is established, as described in the previous sub-sections, the soil salinity
base map can be created and exported to the database. Therefore, use function: Database » Soil

Salinity Assessment » Create Soil Salinity Base Map as shown in Figure 5 below.
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=7 SAGA AMIS 0,72 (2008) [Debug]

Fls Mcddes Window | Datebass 7

‘b D@ § Comectionatsbese
[Workspace Table '
& Data Vector Data b

= &3 shapes
=4k Polygon e X
{71 0L vty Time Serles »
= By Tables -

1
L

report_salint  Hydrolagical Madelng

Sodl Saliniky

Load Soil Salinity Assessment Map

Closa Database Connection Cre.
—_ Delete

Figure 5. Menu create soil salinity map

SolSalHtvnsMap

A dialog to select the basis map of agricultural fields (polygon shape file) will pop up (see Figure 6
below).

Select a Shapefile as basis map 5[
B Data Objects oka
i
B shapes —I
C| Cancel
01, virbual_wua_fields.shp
Load |
Save |
== Choose a basis map
[Shapes (input)

Fmsead\mﬂaaﬂ basiz for the zoil map

Figure 6. Select basis map dialog

Select the desired shape file and press button Okay. The following dialog (Figure 7) will then be
displayed. Specific attributes (listed in Table 2) are required by the soil salinity assessment method
and will be added to the map's attribute table in the database automatically. An important column in
this context is column “FID”. Each feature (agricultural field) gets a unique identifier (integer number)
which is required by the database management system.

Choose a map name, but do not use any special characters, such as: “+ - * /% & $ § ?”” and do not use
upper case letters. Blank spaces are also prohibited. If you want to separate the map name use the
underscore “_” instead of a minus “-”. It is suggested to add a prefix like “ssm_” to the map name,
where ssm stands for soil salinity map for instance.

The option Primary Key Column allows you to select an existing column to be used as primary key in
the database. It is strongly recommended not to modify the suggested column (FID).

Usually, you do not have to care about the settings in the section Geometry Columns. Use the default
settings.

In section Spatial Reference System you need to specify the spatial reference system of your basis
map. If you do not have any information about the used reference system type in the value “-1”.
Finally press the OK button to export the map to the database.
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Export Shape <virtual_wua_fields.shp>> as SimpleFeal X
— SimpleFeature Hame

MName: ssm_virkual_wua_fields
~Primary Key C:

(¥ Select an existing column g j

" Automatically create a pk column

Geometry Columns

f_table_catalog |

f_table_schema {public ~]
f_geometry_column | geom

coord_dimension |2 |

Spatial Reference System

SRID E

Projected Coord. Systems I Geographic Coord, Systems |

OK ‘ Cancel I

Figure 7. Map export dialog

Table 2. Required soil salinity attributes

Attribute name

Description

FID

yr

mnth

SALINITY
SALINITY V
SALINITY L

SALINITY E

MS_LOW

MS MEDIUM

MS_HIGH

PLANT

Feature identification number (agricultural field). This will
be an integer number and automatically act as the primary
key in the database.

The year in which the soil salinity assessment has been
accomplished.

The month in which the soil salinity assessment has been
accomplished.

The salinity value as a word: low, medium or high.
The salinity value as a number between 0 and 1.

The salinity value estimated by using factors representing
local knowledge.

The salinity value estimated by using factors representing
expert knowledge.

The degree of membership to the fuzzy membership
function low. A value between 0 and 1.

The degree of membership to the fuzzy membership
function medium. A value between 0 and 1.

The degree of membership to the fuzzy membership
function high. A value between 0 and 1.

The plant that was growing in the period before the soil
salinity assessment.
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After pressing button OK in the export dialog (Figure 7) the geometries of the base map will be
exported to the database in the OGC (Open Geospatial Consortium) conform Simple Feature format.
Depending on the file size this process could take a while. After a successful export the soil salinity
map will be automatically loaded into the SAGA Workspace as data type SimpleFeatures.
Additionally, three attribute tables are stored and connected to the soil salinity map in the database.
These tables must not be deleted, otherwise the system does not work properly or breaks down. The
nomenclature of the attribute tables is a combination of a specific prefix + map name as described
below.

@ The table with the prefix “ attr " stores all information about soil salinity. In case the name of
the soil salinity map is: “soil salinity map” the name of the attribute table is:
“_attr_soil_salinity_map”. If this table gets lost, all information will be deleted and can not be
replaced or recovered easily.

@ The table with the prefix “ settings ” contains the parameter settings of the soil salinity
assessment input dialog (Figure 10) for each field and time step.

@ The table with the prefix “ weights " contains the current settings of weighting factors. Each
soil salinity parameter has a weighting factor (degree of importance).

2.5 Deleting a soil salinity map from database

There are different ways to delete a soil salinity map from the database.

@ Deleting the entire soil salinity project: In case you want to delete the entire soil salinity
project (the map and all corresponding attribute tables) use function Delete Soil Salinity
Assessment Map as shown in Figure 5 above. Be aware that all soil salinity data will be lost
in this case. Please read chapter 5 if you want to make a backup before deleting the data.

@ Deleting the soil salinity map only: If you want to delete only the map but keep the soil
salinity data in the database you can use function Database » Vector Data » Delete
SimpleFeature. In this case only the map will be deleted but the three attribute tables,
described in the previous sub-section, will be kept in the database.



CHAPTER 3

Soil Salinity Data Input

In this chapter is described how information about soil salinity at the field scale can be entered into
the system. The existence of a soil salinity base map in the database is a precondition to
accomplish this. In case such a map does not exist, please read the previous chapter (Creating a
Soil Salinity Base Map) first in order to learn how to create and export a map to the database.

3.1 Loading a soil salinity map from the database

In order to access and enter soil salinity data into the system, load a soil salinity map from the
database using function Load Soil Salinity Assessment Map from the menu Database » Soil
Salinity Assessment » Load Soil Salinity Assessment Map (see Figure 8). It is important to use this
function to load the map, because only then SAGA GIS “knows” that the map is not any map, but a
soil salinity map. Otherwise, specific soil salinity functions are not available later on.

File Modues Window | Dastabase 7
1o || § comettombe:
‘Workspace Table

= w Vector Data
= & Shapes

=141 Patygen s
B3 0L vty Time Series

 Hydrolagical Modeling

M|~ | |~ -

Load Soil Salnity

Close Datal Connection Create Sol Salinty Base Map
Dalete Sal Salinicy Assessment Map

Figure 8. Menu load soil salinity map

Choose the desired map in the import dialog and press button Okay. The map will be loaded into
the SAGA Workspace as data type SimpleFeature and displayed automatically.

3.2 Soil salinity assessment input dialog

Figure 9 shows a virtual soil salinity map (ssm_virtual wua_fields). Use the Action Tool X from
the map toolbar in order to select any field in the map and right-click on it to open the context
menu. If the context menu does not pop up, please have a look into section 6.5 Context menus for
help.
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Figure 9. Load Soil Salinity Assessment Dialog

Soil Salinity Assessment

The command Open Soil Salinity Assessment Dialog opens the dialog shown in Figure 10 below that
is used to enter and modify soil salinity information.

5
—Main Settings -~ Calculate Salinity
Select 1D |fid = Selected Field || "] Salinity Assessment Membership — max
Yalue Category o ID
‘ear |2003 Manth INovd Plant ICothun ;] l— _
0,537547
e . medium | 08968 -I-J
Load Settings | weights | 0534167 [0.541957 high  [0.117685
fmin
~ Soil Salinity Variables (local knowledge) | Calculste Salrity |

V' 5ol Colour Do = J— = - Soil Salinity Variables (expert knowledge)
% Mumber of leaching [+ | ¥ Sod texture sand S
IV Water qualty (leaching)  good — J_ e I¥ Plant growth characteristics  normally ~ ——— J— underdeveloped
IV Water quality (imigatior)  good — —— b B o witse sty o —— f— hoh
[V water used for iigation [300-400mm ] e e [>100 <200 cm ¥]
“Surface Drainage System
IV Evenness even — J— niok even ¥ Channels [ Distancetoch, | Maintanance
v morphalogy Isﬂ( Yl |1 :] Imoderatehr j ln’edum 1]
Save I | Cancel |

Figure 10. Soil salinity assessment input dialog

Use the controls of the dialog to enter all available information. Select the agricultural field and the
date in the Main Settings part. Information on soil salinity can be entered into the Soil Salinity
Variables sections for local and expert knowledge. The checkboxes ¥ before each parameter can be
used to activate or deactivate the corresponding parameter. Unmark the box if no information is
available. In this case the parameter is not taken into account in the salinity calculations. All
parameters of the soil salinity assessment input dialog are described in the following tables. Table 3




Soil Salinity Assessment

Manual 15-32

describes parameters of the “Main Settings”, Table 4 “local knowledge”, Table 5 “expert knowledge”,
and Table 6 “Calculate Salinity”.

Table 3. Soil salinity assessment “Main Settings”

Parameter Description

Select ID Defines the column that is used to identify the agricultural fields. In the example
the FID column is used to identify the fields.

Selected Field The selected agricultural field to which the data will be assigned to. If the field
selection changes, the field selection in the soil salinity map will change
accordingly. Thus, the user is always aware to which field the data will be
assigned to.

Year The year (4 digits) of data collection, use FORMAT (YYYY)

Month Select the month of data collection. Note: If data are collected in different month,
but belong to the same data collection period choose the same month. In the
Khorezm Oblast data are collected after the harvesting time in November, thus
always choose Nov in this case.

Plant The plant that was growing on the field before harvest. Type in the name of the
plant or select a plant from the drop down control.

Button Load Settings This button loads previous settings (if exist) of all parameters according to the

Button Weights

selected field, year, and month. This option is useful to avoid the input of
information that is more or less static, like Evenness, Morphology, Soil texture,
Channels, and Distance to channel. Hence, if you like to input data for the year
2008 (November) to field number 1, you can first load the settings from the
previous year 2007 (November). Therefore, type 2007 in the control Year, select
the field number 1 in the control Selected Field, and press the Load Settings
button. If data are available the settings of the controls will change accordingly.

Each parameter has an importance degree or weight, respectively. This is
important for the soil salinity estimation. The higher the importance of a factor the
more weight it has in the salinity estimation method. The relative importance of
each parameter was defined during a workshop with WUA (Water User
Association) chairmen in April 2008 in Urgensh. The default values of the
importance according to the workshop results are shown in Table 9. By pressing
the button Weights the dialog shown in Figure 12 opens. The dialog can be used to
modify the weighting factors.

Table 4. Soil salinity variables (local knowledge)

Parameter

Description

Soil Colour

Number of leaching

Water quality (leaching)

The range is from brown to red. These are the terms used by the farmers, where
brown means low or no salinity, and red determines a highly salinized soil.

The number of leaching processes performed before the last growing season. The
number of leaching processes is an indicator for the salinity before the growing
season.

Farmers distinguish between good and bad water quality according to the origin
of the water. If the water comes directly from the river it is good (not transparent)
water with a high content of clay and nutrients and usually no or low salinity. If
the water comes from a reservoir it is clear and contains no or less clay and
nutrients and is saline to certain degree. Usually: the better the water the less
leaching processes are required. Thus, assumed the number of leaching is equal:
the usage of good water is an indicator for higher soil salinity than the usage of
bad water.
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Water quality (irrigation)

Water used for irrigation

Evenness (Surface)

Manual Soil Salinity Assessment

See parameter water quality (leaching). But, in opposition to water quality of the
leaching process, the usage of good water (lower salinity) leads to lower soil
salinization than water of bad quality.

Approximately the amount of water used for irrigation. Classes range between
0-100; 100-200; 200-300; 300-400; and >400mm. The more water was used the
higher the vulnerability to salinization due to high ground water levels.

The more even a field the better the conditions for leaching and irrigation.

Morphology (Surface) Here we distinguish between hill, sink, and in between in relation to neighboring
fields. If a field is on a hill it is less subject to salinization due to ground water
influence than a field in a sink position.

Table 5. Soil salinity variables (expert knowledge)

Parameter Description

Soil texture

Plant growth characteristics

Ground water salinity
Ground water level
Drainage system

e Channels

«  Distance to ch.

*  Maintenance

The value range is between sand and clay, where the higher the sand content the
higher the negative impact on salinization.

The Hydromeliorative Expedition is using this parameter to identify fields with
similar degrees of salinity in order to define homogeneous areas. The more the
plants are underdeveloped the higher the salinity of the field.

The higher the salinity the higher the risk for soil salinity.
The higher the level the higher the higher the risk for soil salinity.

The number of channels surrounding an agricultural field. The more drainage
channels surround a field the better the drainage conditions. If the field is
surrounded by at least one field, parameter Distance to ch. is not active.

The distance to the nearest channel. This parameter is only taken into account, if
the value of parameter Channels is zero. The closer the nearest channel the better
the drainage conditions.

The maintenance of the drainage network.

Table 6. Salinity calculation results

Parameter Description
Salinity Assessment
*  Value The salintiy value (0.0 — 1.0).
0.0 = no salinity
1.0 = high salinity
The value is calculated by taking all activated parameters into account.
+  Category low, medium, high
« Local The salinity value estimated using only the local knowledge parameters.
«  Expert The salinity value estimated using only the expert knowledge parameters.
Membership
« Low The degree of membership to the category low.
* High The degree of membership to the category medium.
*  Medium The degree of membership to the category high.

Button Calculate Salinity

By pressing this button the salinity value is calculated.
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Table 7. Soil salinity assessment "Save" and "Cancel" buttons

Parameter Description

Button Save By pressing this button the soil salinity data and the control settings are saved to
the database according to the selected agricultural field, year, and month. If a
dataset with these attributes already exists in the database the user will be asked
whether he wants to overwrite it or not.

Button Cancel This button closes the dialog without saving the data to the database.

3.3 Soil salinity calculation

The methodology to estimate soil salinity using local and expert knowledge factors (described in
Table 4 and Table 5) is based on a rather simple approach. Weighting factors (degrees of importance)
are assigned to each soil salinity factor.

The salinity value is calculated as following:

Zfiwi

Salinity="———

z w;
im1

where = soil salinity factor, w = weighting factor, and » = number of factors used.

The definition of importance degrees was done during a workshop with chairmen of water user
associations in April 2008 in Urgensh. These weighting factor default values can be modified by the
user. This function was implemented in order to make the system more flexible during the testing
phase. How to modify and load the weighting factor settings is described in the following sub-section.

A fuzzy logic approach is used to classify the estimated salinity value. Three different categories are
used: low, medium, and high. Additionally, the degree of membership of the salinity value to each
category is calculated using the functions shown in Table 8 below. The degree of membership is a
value between 0 and 1, where the higher the value the stronger the degree of membership. As shown
in Figure 11 below, the fuzzy set membership functions have an overlap of 50 percent. The
classification method allows on the one hand the assignment of the value to a certain category, on the
other hand the degree of membership gives an impression to which direction the value tends. A
salinity value of 0.396, for instance, belongs to the category medium. Using the membership functions
shown in Table 8, the degree of membership to category low is 0.32, to category medium is 0.83, and
to category high is 0. Hence, a salinity value of 0.396 has a tendency to the classification /ow, but no
tendency to category high as illustrated in Figure 11 below.

Table 8. Fuzzy membership functions

Fuzzy set Membership function
low y = cos(Salinity * m)
medium y = sin((Salinity + 7t / 4) * ©'*")

high y = cos(Salinity * 7 + 7)
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Information about membership degrees are provided in the soil salinity assessment input dialog in the
Calculate Salinity section (see Figure 10).

medinm

Iembership degree

=
)
Lk

0.00
0.00

Salinity value

Figure 11. Salinity membership degrees

3.4 Weighting factors

Each parameter that is used to estimate soil salinity has an importance degree or weight, respectively.
The default settings (defined during a workshop with water user association chairmen, see Table 9) are
stored in the software itself. By creating the soil salinity map (as described in chapter 2) the default
settings are copied to the weights attribute table “ weights + map name”. By loading the soil salinity
map from the database the settings currently stored in the weights attribute table are loaded and used.
In order to modify these settings the dialog shown in Figure 12 below can be used. To open the
weighting factor dialog use button Weight from the soil salinity assessment input dialog, shown in
Figure 10. The dialog provides three buttons: (1) Load default to load the default settings; (2) Save to
save the user settings to the weight table “ weights + map name”; and (3) Cancel to close the dialog
without saving the settings.

The controllers to modify the weights represent values ranging from 1 to 10, where the value 1 stands
for low importance and 10 for high importance. The weighting factors are used in the salinity equation
as explained in the previous sub-section.
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Table 9. Importance of soil salinity factors

Factors Importance degree
Local Knowledge
@ Soil colour Medium
Number of performed leaching ~ High
@ Water quality for leaching High
@ Water quality for irrigation High
@ Amount of water for irrigation Medium
@ Surface characteristics High
Expert Knowledge
@ Soil texture Medium
Plant growth characteristics Low
@ Ground water salinity Medium
@ Ground water level High
@ Number of channels Medium
@ Distance to earest channel High
@ Maintenance High
x|
Importance min masx .

~ Soil Saliniy Weights (local knowledge)
Soil Colour (local)

Mumber of Leaching
\Water quality (leaching)
Water quality (irrigation)
Water used for irrigation
Evenness

Morphology

——
=

~ Soil Salinity Weights (expert knowledge)
Soil texture

Plant growth characteristics
Ground water salinity

Ground water salinity
Number of channels

Distance to drainage network

Maintanance of d

Load Default | Save |

Figure 12. Dialog weighting factors
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CHAPTER 4

Visualizing and Analysis of Soil Salinity Data

4.1 Load soil salinity data

If the soil salinity map is displayed in the GIS and activated in the SAGA Workspace click with the
right mouse button anywhere in the map in order to open the context menu shown in Figure 13. In
case one or more fields (features) are selected the context menu will contain two more options.
Click with the left mouse button on an empty area in the map in order to unselect the fields and
right-click again to open the context menu. Select Load Soil Salinity Data to open the dialog
shown in Figure 14. If the context menu does not pop up, please read section 6.5 Context menus.

=10] x|
24 128 3;z|
w
o~
o
o~

Edit Selected Shape

Add Shape

Delete 5elected Shiapels)
fidd Park

Selected Part
Selected Point

Load Soil Salinity Data

Compare Soil Salinity Maps

o os o8 12 16 20 24 28 22 36 40 4

Figure 13. Context menu load soil salinity data

Load Soil Salinity AssesSHe.d|

Date
{ |z007

ﬂ |N0v;’

Cancel I

Figure 14. Load soil salinity data dialog
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Select the desired year and month in the dialog and press button Load to load the corresponding data
from the database into the map's attribute table. The map's colors will change automatically according
to the salinity values of the fields. Open the map's attribute table in order to show the data. Please read
section 6.6 if you do not know how to open an attribute table.

A soil salinity legend was implemented directly into the system. Please read section 6.8 in order to
learn how to create or modify the legend manually. The predefined legend consists of five categories
which are explained in Table 10.

Table 10. Predefined legend of the soil salinity map

Color Classification Salinity values
(light green) low 0.0001 —0.149
- (green) low - medium 0.15-0.29
(yellow) medium 0.3-0.49
- (orange) medium - high 0.5-0.749
B ) high 0.75—-1.0
B biack) No data 0.0

4.2 Comparing soil salinity maps

For the purpose of soil salinity monitoring a function was implemented to visualize trends in soil
salinization of the area under study. The user can easily compare soil salinity of two different time
steps. Therefore, right-click on the soil salinity map and select Compare Soil Salinity Maps in order to
open the comparison dialog (see Figure 15).

[ X

Compare Maps

“First time step

Year |2006 ¥| Month INCN 'I

Second time step

Year |2008 ~| Month INcw 'I

Cancel |

Figure 15. Soil salinity map comparison dialog

Select the year and month of the first and second time step and press button Compare. A new map
(“ssm_comparison”) containing salinity differences of each agricultural field will be added to the
workspace and displayed automatically. A predefined legend is used to show the differences or trends,
respectively (see Table 11).

Note: there is still a small bug in the function. If the dialog (Figure 15) is closed by the user, the

comparison map jumps to the background and will be covered by other maps. To solve the
problem, simply click on the comparison map's window in order to bring it to the front again.
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Table 11. Legend of the comparison map

Color Classification Salinity values
- (green) positive trend 0.0-1.0
(yellow) slightly negative trend ~ (-0.001) — (-0.1)
(dark yellow) negative trend 1 (-0.1001) — (-0.2)
P (orange) negative trend 2 (-0.2001) — (-0.35)
- (red) negative trend 3 (-0.35) - (-1.0)

4.3 Soil salinity reporting function

The reporting function was implemented to support monitoring and trend analysis. The result is a table
containing soil salinity data and statistical information about trends and changes of the agricultural
fields. It summarizes all available data of currently selected fields. Please note that the report will be
created for selected fields only. If the map contains a lot of fields you should avoid to select too many
fields per report. Otherwise the report table becomes confusing due to a large number of columns. In
order to create the report table select the desired agricultural fields in the soil salinity map (see section
6.7) and right-click on the map to open the context menu (see Figure 16)

Edit Selected Shape

Add Shape

Delete Selected Shape(s)
Add Part

Delete Selected Park

Delete Selected Point

Load Soil Salinity Data
Open Soil Salinity Assessment Dialog

Compare Soil Salinity Maps

Figure 16. Context menu create soil salinity report

Select function Create Soil Salinity Report to create the report table, shown in Figure 17 below. For
each selected field one column will be created. The agricultural fields can be identified by the column
name (Field + FID number) — where FID is the feature identification number that is automatically
added to the attribute table (see section 2.4).

=10l x]
- .
Year | Field 1 Field 3 Field 4 | Fleld 5 | Fields | Field7 Field 9
1 0491509 0573302 0.607442 0532642 0297642 0125531 0397170
2 zo7 0453962 0391792 0.650233 0441699 0517453 0555057 0468679
3 |oo08 0549523 -1.000000  -1,000000  -1,000000 0297642 0424528 -1,000000
4 2009 -1,000000  -1.000000  -1,000000  -1.000000  -1,000000 0623302 -1,000000
5 |Mean 0438365 0.482547  0.628837 0467170 0370912 0433117 0.432925
6 |Mn 0453962 0.391792  0.607442 0441698 0297642 0425581 0397170
T Max 0549523 0.573302  0.AS0233 0532642 0517453 0623302 0468679
__0 DIFF_max_rnin 0.035561 0. 181510 0.042731 0.0909%44 0.219G611 0.497721 0.071509
a9 Trend 0058114 -0.181510 0.042791 -0.090944 0.000000 0.497721 0.071509

Figure 17. Report table
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The report table will be added to the SAGA Workspace (Data) in the Tables section. The name of the
table is: report _salinity.

The attribute table shows available salinity values for each year. Moreover, it gives information about:

Salinity (year) The salinity value. The negative value (-1.0) indicates that no data are available for the
corresponding year.

Mean salinity The mean salinity value over the entire period.

Min The minimum salinity value.

Max The maximum salinity value.

Diff max_min The difference between the maximum and minimum salinity value.

Trend The difference between the first salinity value (first year) and the last value (last year). If

the trend value is positive, the salinization in the last year is worse than in the first year. If
the value is negative, salinzation of the last year is less than in the first year.

The salinity values can be visualized easily using a spreadsheet application like OpenOffice Calc or

Microsoft Excel. Therefore, save the table to the hard disk (see 6.4) in dBase format and open it with
the spreadsheet application.

Please note that this functionality is still under construction. Specific requirements need to be
discussed with (potential) users.



CHAPTER 5

Backup

Two alternatives to make a backup of the soil salinity database are described in this chapter. You
can either make a backup of the entire database (see 5.2) or export only the desired tables as text
files to any storage media (see 5.1). If the database is installed on a PC, it is strongly recommended
to frequently save backups on an external hard disk, flash drive, DVD etc. At least after a lot of
time has been spent to enter huge amounts of data.

5.1 Exporting a single table to hard disk

In order to export a table from the database to the hard disk use function Database » Table »
Table to .csv (see Figure 18). A dialog will pop up where you select the desired table from the
database and the directory on the hard disk where you want to save the copy. The table will be
exported as text file in Comma Separated Value (.csv) format. This format can be opened with any
text editor or spreadsheet application like Open Office Calc or Microsoft Excel.

| Database *
Connect to Database i
impor Tale
Vector Dat 3
seerbee Export Table
S0L Table to .csv
Tirme Series Delete Table

Hydrological Modeling

Sail Salinity Assessment

Close Database Connection

Figure 18. Export table to .csv

5.2 Making a database backup (dump file)

Making a database backup using the program pgAdmin III. Figure 19 shows how to start the
program pgAdmin III which will be automatically installed during the PostgreSQL installation.
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Citri Program Meighborhood — »

) CorelDRAW Graphics Suite %3
4 Dolumente ¥ ) Microsoft Office
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Figure 19. Starting pgAdmin I1I

pgAdmin III is an administration tool for PostgreSQL that requires the database administrator
passwort. Figure 20 shows how to open the database backup dialog. Therefore, right-click on a
database item displayed in the database tree and select Backup...in the context menu.

=10] %]
Fle Edi Vicw Took Help
. o e () |22 %
P W wEES®
03“' Brovecar X Praperiss | atistics | Dependendies | Depencents |
] Servers(l) Py [ a
El- [} PestgraSOL Database Server 8.3 (boahost:5432) m?':—tv" l \: Y
E Databe: il So
X ,.‘,.‘.. Covarmsr postares
o posigs e
postgras i
PR ) l Tabiespace pg_detadk
R emolate_poskols | =/ ostaul tabinspace g _dafault
¥ | Encodng UTFa
i Tobdes;  Rafrach public
- Grom | Newe Gt m Yas
s Logn R e lBron '\“-:r.
o -
CREATE soript ’
x
-~ Darabase: uz_db =
-= DROP DATABASE uz_db;
CREATE DATABASE uz_db =
T s ;I_J
Ratrimg Database debads, ., Done. 0,00 sazs

Figure 20. Open backup dialog
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E; Backup Database uz_db | =101 %]

Filename I E:\db_dumpiuz_db_tar.backup _I
— Format

(" COMPRESS (" TAR (+ PLAIN

V¥ Blobs T PIEQIN ?p:ons

Only data
™ With OIDs &
................................. I only schema

r. Mo owner
¥ Create DB
I~ Drop DB
. [ | Disable Trigaer

I Disable $ quoting

IV Verbose messages

Options IMessaqes I
Help | ok Cancel

Figure 21. PostgreSQL database backup dialog

In the database backup dialog (see Figure 21) the user can define the options to create a database
backup file. Depending on the size of the database one should use option PLAIN or COMPRESS. The
option PLAIN produces an ASCII text file containing all SQL commands to restore the database and
data. This option can be used for “small” databases. For huge databases the option COMPRESS
should be used which reduces the file size of the database dump file.

5.3 Restoring the backup (dump file)

Restoring a database backup using the program pgAdmin III. Figure 20 shows the context menu with
functions to administer the PostgreSQL database. The option Restore is below the entry Backup.

5.4 pg dump

Alternatively to pgAdmin III the command line tool pg dump can be used by advanced users to
backup and restore a database. A detailed description is given here:

http://www.posteresqgl.org/docs/current/static/app-pgdump.html




CHAPTER 6

Some SAGA Features

This chapter gives an overview about some useful basic SAGA features.

6.1 Toolbars

The standard toolbar

‘w|Ede| e

6.2 SAGA Workspace

In the Data Tab of the SAGA Workspace the user finds all data (Shapes, SimpleFeatures, Tables,

Grids, and TIN's) that were loaded into the GIS. Double-click on an item displays the
corresponding feature in a map. Click on the icon in the standard toolbar in order to open or

close the workspace window.

I

&= Data
= & Shapes
=] {1 Palygon
[#] -Cj- 01, virtual_wua_fields.shp
[-1- 3 SimpleFeatures
= -Cj- Paolygon
[+ (j- 01, ssm_virtual_wua_fields
= B Tables
[ report_salinity

&= Data | ®g. Modules
E@ Maps | n Data * ] E Maps *

Figure 22. SAGA Workspace
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6.3 Messages

Almost all commands executed by the user send a message to the SAGA message window. Here the
user gets information about the successfulness of the commands. In case the window is not displayed
use button IE from the standard toolbar or menu Window » Show Message Window to open it.

6.4 Saving features from workspace to hard disk

Right-click on an item in the workspace (see Figure 23) to open the context menu and choose the Save
as function of the corresponding item (Save Shapes as...; Save Table as...; etc.).

6.5 Context menus

In case a map's context menu does not pop up on mouse right-click make sure that the map is
activated in the SAGA Workspace. Perform a left-click on the map item in the Workspace to activate
the feature as shown in Figure 23 below.

xI
& Data
= ¥ SimpleFeatures

=11 Polygon
[+ {:]. 01, ssm_virtual_wua_fields

& Data I M Modules
E@ Maps I_u-DaI:a * Ij Maps *

Figure 23. Activate a map

6.6 Opening an attribute table

Click on the I# symbol next to a SimpleFeature or Shape file in the SAGA Workspace as shown in
Figure 24 (left). Double-click on the attribute table Figure 24 (right) to open it.

Workspace 3 | Workspace o
& Data & Data
=8 Shapes -5 Shapes
B4} Polygon E{j Palygon
*{j 01. virtual_wua_fields.shp E{j 01, virtual_wua_fields.shp

----- @ virtual_wua_fields.dbf

Figure 24. Open attribute table

6.7 Selecting one or more fields in a map

In order to select one or more fields (features) in a map first select the action tool X from the map
toolbar and left-click on a field to select a single field. Press and hold the Shift key and left-click on
other features to add them to the selection. Alternatively you can draw a rectangle with the mouse by
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using the left mouse button. All features touched by the rectangle will be selected. In order to deselect
a feature from the selection, hold the Shift key and left click on the feature.
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DON'Ts

Never delete an attribute table manually from the database! If you want to delete a soil salinity
project,use function Database W Soil Salinity Assessment » Delete Soil Salinity Assessment Map.
This automatically deletes the corresponding attribute tables.



